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VAXmate V1.1 Customer Letter 

( To the VAXmate User's Guide reader, 

( 

( 

These pages contain corrections to pages in your VAXmate User's Guide, 
Volume 1. To update your guide with these pages, use the following table. 
The table lists the old pages you should remove and the new replacement 
pages you should insert in your guide. 

PAGES TO REMOVE 

Chapter 1 

1-1, 1-2 
1-9 through 1-12 

Chapter 3 

3-13, through 3-16 

Chapter 4 

4-7, 4-8 

Chapter 5 

5-5, 5-6 
5-9, 5-10 

Chapter 6 

6-17, 6-18 

Chapter 7 

7-1, 7-2 
7 -9 through 7-11 

PAGES TO INSERT 

1-1, 1-2 
1-9 through 1-12 

3-13 through 3-16 

4-7, 4-8 

5-5, 5-6 
5-9, 5-10 

6-17, 6-18 

7-1, 7-2, 7-2.1 
7 -9 through 7-11 
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PAGES TO REMOVE PAGES TO INSERT ~~ 

Chapter 8 

8-7 through 8-22 8-7 through 8-22 

Chapter 10 

10-3, 10-4 10-3, 10·4 

Chapter 12 

12-13, 12-14 12·13, 12-14 

Chapter 20 

20-17, 20·18 20-17,20-18 

Appendix A 

A-7 through A-10 A-7 through A-10 /\ 

"---j 

Appendix B 

B-5 through B-10 B·5 through B-10 
B-15, B-16 B-15, B-16 
B-25 though B·27 B-25 though B-27 

Appendix C 

C-1 through C-15 C-1 through C-15 
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Chapter 1 
Getting Started 

With MS-Windows 

MS-Windows lets you work visually by organizing your tasks in windows. 
With MS-Windows, you can have more than one window on your screen, each 
running a different application. Thus, you can simultaneously work on sev
eral tasks, such as writing a memo, updating a project status report, and 
organizing data for a monthly report. 

With MS-Windows, you switch from one application to another by clicking 
the mouse button or pressing keys. Because you never have to stop running 
an application, you can continue in any application where you left off. 

With MS-Windows, you do not have to memorize formats or type many com
mands. Each application has all the necessary commands contained in a series 
of menus; you select a command from a menu. 

MS-Windows lets you transfer information between your MS-Windows applica
tions. For example, you can copy information from a project status report to 
a monthly report while running both in the work area of your screen. 

This chapter describes how to: 

• Start MS-Windows 

• Work in MS-Windows 

• Run an application 

• Use the Information System 

• Scroll a window 

• Use menus and commands 

• Use a dialog box 

• Finish an application 

1-1 



IIIII GETTING STARTED WITH MS· Windows 

Starting MS-Windows 

Information on starting MS-Windows and other introductory MS-Windows 
material, including definitions for terms such as icon, work area, and mouse, 
is contained in your handbook. If you have not read the handbook, do so 
before continuing. 

Initial Window 

The first window you see when you start MS-Windows depends upon how 
MS-Windows is installed on your workstation. When MS-Windows is installed 
on your workstation, you can: 

• Run a specific application automatically in the work area each time you 
start MS-Windows 

• Load specific applications as icons 

This is desirable if you consistently use several applications. 

• Open the MS-DOS Executive window 

If you run and load applications when MS-Windows is installed, the first 
window you see is the application that is set up to run automatically. You 
also see the icons for the applications in the icon area at the bottom of the 
screen. For information about running and loading applications, see 
Chapter 3. 

If you do not run or load applications when MS-Windows is installed, the 
first window you see is the MS-DOS Executive window. You can load applica
tions into the icon area. 

Working in MS-Windows 

You work in MS-Windows by using the mouse or the keyboard to select and 
perform commands. You will probably use the mouse most often because 
you can enter most commands by pointing the mouse to the command and 
clicking the left mouse button. In general, this guide describes how to enter 
MS-Windows commands, using the mouse. For information on using the key
board to enter commands, see Chapter 6. 

If you unplug your mouse and plug it back in, the mouse will not work. To 
get your mouse to work again, exit and restart MS-Windows. 
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Screen 1-2 Dialog Box 

A dialog box is a rectangle, resembling a window, which overlays a portion 
of the screen in which you select a command. If you display several windows 
in the work area, the dialog box can overlay portions of more than one 
window, depending on the size of the windows and the dialog box. 

The dialog box contains areas where you either type the information 
required by MS-Windows or select options to supply the needed information. 

Often, a dialog box is displayed with some information already in it, showing 
what you have selected on the screen or options you selected earlier. Also, 
some options may be disabled. 

Mter you enter information or select an option, you execute the action by 
selecting a command button in the dialog box. 
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IIIII GETTING STARTED WITH MS- Windows 

The following sections describe the components of a dialog box. 

Text Box 

A text box is where you type information needed to carry out a command. 
Figure 1-2 shows a text box. 

File name: L!1.!!!!!~!!!;t!!!!I _______ ---.J 

Figure 1-2 Text Box 

What you type is displayed to the left of the blinking vertical line, called the 
insertion point. To position the insertion point in the text box, click where 
you want the insertion point moved. As you type, the insertion point moves 
to the right. 

To correct typing mistakes, press the Word Char key. Each time you press it, 
one character to the left of the insertion point is deleted. 

The text box can: 

• Be blank when the dialog box is displayed 

• Contain text if you already selected something applicable for the 
command 

• Contain a default option 

If information is already present in the text box, you can type new informa
tion. When you press the first key, any information already present is 
removed. You can also press the Word Char key to delete information already 
in the text box. 

List Box 

A list box lists the choices you can select for a command. Figure 1-3 shows a 
list box. 
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GETTING STARTED WITH MS-Windows 11111 

C:\WIH\PCAPP 

( Open) 

( Cancel) 

Figure 1-3 List Box 

You can distinguish between files, drives, and directories listed in a dialog 
box. For example, in the list box shown in Figure 1-3: 

MYFILE 

[-A-] 

[ .. ] 

[MYDIR] 

Is the name of the file, MYFILE. 

Represents drive A. Brackets and hyphens surround the name 
of a drive. 

Represents the parent directory (one level up). 

Represents directory MYDIR. Brackets surround the name of a 
directory. 

To select an item in the list box, click on it_ 

Option Buttons 

Option buttons let you select one option from a group. They are labeled to 
describe their functions. Figure 1-4 shows the option buttons for controlling 
the keyclick volume. 

Keyclick voluille 0 No sound 
OSoft 
@ I nterillediate 
Oloud 

Figure 1-4 Option Buttons 

To select an option from a group, click on it. 
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IIIII Getting Started With MS· Windows 

Check Boxes 

Check boxes represent options that you can turn ON or OFF. They are 
labeled to describe the functions of the options. When an X is displayed in 
the check box, the option is ON. Click on X again to turn the option OFF. 
You can select as many check boxes as needed. Figure l-S shows a check 
box for a mouse option. 

Mouse Options 
~left/right ~ouse buttons s~apped 

Figure 1-5 Check Box 

To select a check box, click on it. 

Command Buttons 

Command buttons are large rectangular buttons (with rounded corners) that 
are labeled to describe how thay affect the command you selected. Figure 
1-6 shows sample command buttons. 

( Ok ) (Cancel) 

Figure 1-6 Command Buttons 

To select a command button, click on it. 
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Using the MS-DOS Executive Window IIIII 

Using the File Name 

To run an application in your default directory, double-click on the file 
name of the application you want to run. 

The file name is highlighted. 

The cursor temporarily changes to an hourglass, indicating that MS-Windows 
is loading the application into memory. 

The application you selected replaces the MS-DOS Executive application in 
the window. The MS-DOS Executive application changes to an icon. 

Using Temporary Files 

Some applications that run with MS-Windows create temporary files with the 
file extension .TMP to store your work. 

The file names for temporary files begin with a tilde character and letters 
indicating the application name. For example, a temporary file for MS-Paint 
has the file name ~SP·.TMP. 

You can create a special directory on your local hard disk drive to hold 
temporary files. To send temporary files to a directory, put the SET TEMP 
command in your AUTOEXEC.BAT file. 

Do not delete these files while MS-Windows is running, because an applica
tion may be using them. You can delete them after quitting your 
MS-Windows session. 

Running Batch Files 

You run batch files only from the MS-DOS Executive window. If you run a 
standard application from a batch file, you should create a PIF for the batch 
file. For more information about PIFs, see Appendix C. 

Set options in the batch file's PIF to be the same as the application's PIF. 
However, set the Memory Required and Memory Desired options for the 
batch file's PIF to 32K, regardless of the memory requirements for the 
application. 
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IIIII Using the MS-DOS Executive Window 

Using MS-DOS Commands and Programs 

MS-DOS commands are divided into three groups: 

• Commands you cannot use from MS-Windows 

• Commands you run from MS-Windows with COMMAND.COM 

• Commands you run from the MS-DOS Executive window 

Those commands that you cannot run from MS-Windows, you can run from 
the MS-DOS operating system prompt. Or, you can put these commands in 
your AUTOEXEC.BAT file, which runs automatically before MS-Windows 
starts. For more information on MS-DOS commands and programs, see Volume 
2 of this guide. 

The MS-DOS commands you should not run from MS-Windows are: 

APPEND 
ASSIGN 
CHKDSK 
CTTY 
FONT 

GRAFTABL 
GRAPHICS 
JOIN 
KEYB 
LCOUNTRY 

MODE 
NET START 
PRINT • 
RECOVER 
SELECT' 

SHARE 

The MS-DOS commands you can run in MS-Windows from the Command win
dow are: 

BREAK ECHO MORE SET 
CHDIR' ERASE' PATH SHIFT 
CLS EXIT PAUSE TIME' 
COPY' FOR PROMPT TYPE 
DATE' GOTO REM VER' 
DEL' IF REN' VERIFY 
DIR' MKDIR' RMDIR' VOL' 

The MS-DOS commands you can run from the MS-DOS Executive window are: 

ATTRIB 
BACKUP 
COMMAND 
DEBUG 
DISKCOPY 

EDLIN 
EXE2BIN 
FC 
FDISK 
FIND 

FORMAT' 
LABEL 
LINK 
NET 
PERMIT 

• These commands have an MS-Windows equivalent. 
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Using the MS-DOS Executive Window IIIII 

Running an MS-DOS Operating System Program 

To run an MS-DOS command in MS-Windows with COMMAND.COM: 

1. Select the RUN command from the File menu in the MS-DOS Executive 
window. 

2. In the dialog box, type: 

COMMAND 

3. Click on the Ok command button. 

The MS-DOS command processor starts in a window titled "Command." 

4. Type the MS-DOS command and command arguments you want at the 
MS-DOS prompt. 

S. To stop using COMMAND.COM, type: 

EXIT 

The window title is now enclosed in parentheses. 

6. Close the window. 

To run an MS-DOS command from the MS-DOS Executive window: 

1. Select the RUN command from the File menu. 

2. Type the command name and its arguments in the dialog box. 

3. Close the window. 

If the application does not stop automatically, type the Exit command 
and then close the window. 

Finishing an MS-Windows Session 

To finish an MS-Windows session: 

1. Save all files you have worked on. 

2. Exit from any standard application still running in a window or as an 
icon. 
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IIIII Using tbe MS-DOS Executive Window 

3. From the MS-DOS Executive window, end your MS-Windows session 
by using one of the following methods: 

• Double-click on the System menu box. 

• Select the Close command from the System menu. 

• Select the End Session command from the Special menu. 

With any method, a dialog box is displayed, indicating that this action 
ends your MS-Windows session. 

4. Click on the Ok command button. 

MS-Windows closes, and the MS-DOS operating system prompt is dis
played on the screen. 

NOTE 
You can now enter MS-DOS commands. To restart MS-Windows 
from the MS-DOS operating system prompt, type: 

WIN 

Press the Return key. The DIGITAL logo is displayed, followed by 
MS-Windows. 

5. Turn off your workstation. 

6. Remove your key diskette if you do not want anyone else to access your 
files. 

If you try to close MS-Windows while an MS-Windows application such as 
Notepad is still running, MS-Windows displays a dialog box and lets you save 
the updated data file. 

If you try to close MS-Windows while a standard application is still running, 
MS-Windows displays a dialog box indicating an application is still running. 
The name of the active application is displayed in the title bar of the dialog 
box. Close the identified application, then close MS-Windows again. 
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Working With Files 11111 

Deleting More Than One File 

To delete more than one file at a time, select all the files you want to delete, 
then follow steps 2 and 3 in the previous section. 

Printing a Text File 

To print text files, select the Print command from the File menu. With the 
Print command, you can print any files you can display on your screen. 

NOTE 
Most applications have a command that prints files you create with 
that application. You should use the application command when 
possible. 

To print a file: 

1. Click on the file name of the text file you want to print. 

The file name you selected is highlighted. 

2. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. Figure 4-3 shows the Print 
dialog box. 

Print: Hmllj',"t.'tI 
( Ok ) [Cancel) 

Figure 4-3 Print Dialog Box 

If the file name is not the one you want to print, type the correct file 
name over the one displayed. You must type the entire file name, 
including any file extension. 
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11111 Working With Files 

3. Click on the Ok command button. 

The MS-DOS Executive window displays the Print Spooler dialog box, 
telling you the file is being sent to the Spooler for the default printer. 
Figure 4-4 shows the Print Spooler dialog box. 

NOTE 

§ NS-DOS Executl ue 

Sending 
DOTHIS.TXT 

to p~int spoole~. 

(Cancel) 

Figure 4-4 Print Spooler Dialog Box 

Printing does not start until the file has been sent to the Print 
Spooler. The length of the delay before the printer starts depends 
on the complexity and length of the file you are printing. 

For more information about the default printer and how to select it, see 
Chapter 8. 

To cancel the print request, click on the Cancel command button. 

Using the Spooler 

The MS-Windows Spooler is an application that stores files waiting to be 
printed. When you execute the Print command from the MS-DOS Executive 
or from a Desktop application: 

• The Spooler application starts. 

• The Spooler icon is displayed in the icon area. 

• A file is sent to the Spooler application. 

• The Spooler starts to print the file on your printer, if no other files are 
printing. 
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Working With Directories and Disks 11111 

Changing How File Names Are Listed 

The View menu commands change how file names are listed in the MS-DOS 
Executive window. 

When you first start MS-Windows, the files in the MS-DOS Executive window 
are listed in alphabetical order. The directory names are at the top of the list. 

However, you can list files in a different order, such as by size or by the date 
they were created or changed. You can also list files having the same file 
extension. 

To see only files having the same file extension, you must specify the file 
extension. To specify the type of files you want to view, use the Partial 
command. 

To view a partial list of files: 

1. Select the Partial command from the View menu. 

MS-Windows displays the Partial dialog box. Figure 5-3 shows the Par
tial dialog box. 

Partial: II.:-' ________ ....J 

( Ok ) (Cancel) 

Figure 5-3 Partial Dialog Box 

2. In the text box, type the file names you want to see. 

Use wildcard characters (* or ?) to tell MS-Windows which kind of file 
to display. For example, to display all file names with the file extension 
.EXE, type •. EXE in the text box. 

3. Click on the Ok command button. 
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IIIII Working With Directories and Disks 

Displaying Multiple Directories 

You can display more than one MS-DOS Executive window at a time. This is 
useful for displaying two different directories at the same time, one directory 
in each MS-DOS Executive window. 

To display a second MS-DOS Executive window: 

1. Use the Run command to open the second MS-DOS Executive window. 

The file name is MSDOS.EXE. 

2. In the new MS-DOS Executive window, double-click on the directory 
path name you want to display. 

The selected directory is displayed in the second MS-DOS Executive 
window. Two different directories are displayed, one directory in each 
MS-DOS Executive window. 

If you display the same directory in multiple windows, only the directory in 
the active window is updated when you create, delete, rename, or copy a 
file. To update the listing in an inactive window, move the mouse to that 
window and click on the highlighted drive icon. 

Printing a Directory Listing 

To print a directory listing, use the Print command. The directory listing is 
printed as it is displayed in the MS-DOS Executive window. 

To print a directory listing: 

1. Click on the directory name. 

2. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. 

3. Click on the Ok command button. 

The listing of the selected directory is printed. 
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Working With Directories and Disks 

3. Click on the option button of the disk drive containing the new 
diskette. 

4. Click on the Ok command button. 

The system displays a warning that any data on the diskette in the drive 
will be destroyed. 

5. Click on the Ok command button to continue or click on the Cancel 
command button to stop. 

Preparing a System Diskette 

A system diskette contains the files necessary for starting the MS-DOS oper
ating system. 

To prepare a system diskette: 

1. Prepare a diskette by using the Format Data Disk command. 

2. Ensure the new diskette is in the disk drive to which you want to copy. 

3. Select as your current drive a drive that contains the system files. 

4. Select the Make System Disk command from the Special menu. 

MS-Windows displays the Make System Disk dialog box. 

5. Click on the option button of the disk drive to which the MS-DOS sys
tem files are to be copied. 

6. Click on the Ok command button. 

Copying starts when you click on the Ok command button. While the 
MS-DOS system files are being copied, the dialog box remains on the 
screen and the arrow changes to an hourglass. 

When complete, the dialog box is removed from the screen, and the 
hourglass changes to the arrow. 

IIIII 
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IIIII Working With Directories and Disks 

Naming Disks 

To assign a name (a volume name) to a diskette, use the Set Volume Name 
command. The volume name identifies the contents of the disk. 

To name a disk: 

1. Click on the symbol of the disk drive containing the disk you want to 
name. 

2. Select the Set Volume Name command from the Special menu. 

MS-Windows displays the Volume Name dialog box, containing the cur
rent name if any exists. Figure 5-5 shows the Volume Name dialog box. 

Uolullte Halite: 1.:..11 _____________ ---.. 

( Ok ) (Cancel) 

Figure 5-5 Set Volume Name Dialog Box 

3. In the text box, type a name. 

Only the first twelve characters are accepted. 

4. Click on the Ok command button. 

5-10 
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Using the Keyboard IIIII 

Continue pressing the arrow keys to move beyond the window border to 
the size you want. A line shows where the new window's border is 
located. 

To make the window smaller, you must move the size box beyond the 
window border and back inside the window border. 

4. Press the Return key. 

MS-Windows changes the size of the window and adjusts the size of any 
adjacent windows. 

Making a Window Fill the Entire Screen 

To zoom a window so that it fills the entire screen: 

1. Switch to the window you want to fill the entire screen. 

2. Select the Zoom command from the System menu. 

The window you selected zooms and fills the entire screen including 
the icon area. 

To zoom a window, you can also: 

1. Switch to the window you want to fill the entire screen. 

2. Press the Alt/Return keys. 

The window you selected zooms and fills the entire screen including 
the icon area. 

To return the window to its former size: 

• Use the Zoom command again. 

• Press the Alt/Return keys to restore the window to its former size. 

Moving a Window 

To move a window to another position in the work area: 

1. Switch to the window you want to move. 

2. Select the Move command from the System menu. 

MS-Windows diplays the icon of the application in the middle of the 
window. 
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IIIII Using tbe Keyboard 

3. Press the arrow keys until the icon is where you want the window to be 
moved. 

4. Press the Return key. 

The window is moved to the position you selected. MS-Windows adjusts 
the size of the other windows in the work area. 

Receiving Messages From Another Application 

To see a message sent by another application, switch to the window whose 
title bar is flashing or to the flashing icon: 

1. Hold the Alt key and press the Tab key until the window or icon of the 
application sending you the message is highlighted. 

2. Release the Alt key. 

The message is displayed when you switch to the window or icon of the 
application sending you the message. 

Printing Screen Images 

With MS-Windows, you can send the information displayed on the screen to 
your printer, on LPT1. To print a screen, the GRAPHICS command must be 
loaded and run before MS-Windows starts. The key diskette runs the 
GRAPHICS command for you. For more information on the GRAPHICS com
mand see Chapter 32. 

To print your screen: 

1. If you are using a local printer, be sure your printer is attached and on 
line. 

2. Ensure the screen contains the information you want printed. Everything 
displayed on the screen is printed. 

3. Press ShiftjPrt Sc. 

The screen is printed. This operation may take a few minutes. 

NOTE 
Do not press ShiftjPrt Sc if LPT1 is being used by another 
application. 
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Chapter 7 
Running 

Standard Applications 

This chapter describes how to: 

• Run standard applications in a window 

• Run standard applications outside a window 

• Transfer information between standard applications 

• Run large standard applications 

• Run special applications 

Working with Standard Applications 

A standard application is an application (with a .EXE, .BAT, or .COM exten
sion) that you can use with MS-Windows, even though it was not designed 
for this use. (MS-Windows applications, such as Notepad and Clock, are spe
cifically designed to be used with MS-Windows.) 

When you run a standard application with MS-Windows, you continue to use 
the commands and functions of the application. For many standard applica
tions, MS-Windows lets you run several applications and switch from one 
application to another. 

Many standard applications can run in a window, sharing the work area with 
other applications in their own windows. However, some standard applica
tions require the entire screen and run outside a window. 

Whether a standard application runs in a window depends on how it: 

• Uses memory 

• Processes input/output (I/O) activities 
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IIIII Running Standard Applications 

When an application runs on your workstation, it processes I/O activities that 
use the workstation's resources. These resources include: 

• Computer memory 

• Communications ports 

• Video display screen 

• Keyboard 

If a standard application uses standard MS-DOS supplied IjO procedures and 
memory allocation, it can run in a window, because MS-Windows emulates 
the I/O activities that are compatible for MS-DOS. 

If a standard application does not use standard MS-DOS supplied I/O proce
dures or standard memory allocation, it cannot run in a window, because 
MS-Windows cannot provide the interface for IjO activities. These standard 
applications provide their own interface for I/O activities. 

NOTE 
Standard applications must run under MS-DOS Version 3. 10 or later 
to run from MS-Windows. 

Using Program Information Files 

A program information file (PIF) contains information about how a standard 
application uses workstation resources. The system administrator enters this 
information into a PIF for the standard application, and the information is 
used by MS-Windows. Each standard application you use should have a PIF 
associated with it. 

Included with your MS-Windows software package are PIFs for many standard 
applications. If you try to run an application that has no PIF, MS-Windows 
uses default settings for the resources. However, the system administrator 
should create a PIF for the application. 

An application can have more than one PIF associated with it. For example, 
you can have two versions of the same application. One version can require a 
large amount of memory, because you use all the features of the application, 
while another version can require less memory, because you use only a few 
features. 
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Running Standard Applications IIIII 

Some applications require more than one PIF. Each file with a .EXE, .COM, 
and .BAT extension that an application runs must have a PIF associated with 
it. 

If you are running a batch file (an application with a .BAT extension) that 
redirects I/O, you must set the Directly Modifies Screen option in its PIF file 
and run it from the MS-DOS Executive window. See Appendix C for more 
information on creating PIFs for standard applications. 

NOTE 
You should not run a batch file from a COMMAND.COM window if 
the file includes redirected I/O or piping. 

You can run an application by selecting its PIF in the MS-DOS Executive 
window. When you select the PIF, MS-Windows loads and runs the applica
tion named in the PIF. 
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Running Standard Applications 

When you paste information to a terminal emulator, you must first enable 
HOSTSYNC under VMS by typing: 

$ SET TERMIHAL/HOSTSYHC 

This command prevents data overruns. 

You cannot paste: 

• Information from the Clipboard to an application that runs outside a 
window 

• Graphics information from the Clipboard to any standard application 
(inside or outside a window) 

NOTE 
Text is stored in its character (ASCII) representation. When you 
use the Copy or Paste commands, the text is also transferred in this 
character representation. 

To use the Paste command: 

1. Switch to the window into which you want to paste the information. 

2. Move the cursor where you want to insert the information. 

3. Select the Paste command from the System menu. 

11111 

The selected text is inserted in your application at the cursor location. 

Using the Prt Sc Key 

You can also transfer information to the Clipboard by using the Alt/Prt Sc 
keys. To copy a standard application's window to the Clipboard: 

1. To copy from a standard application that runs in a window, make sure 
the window is the active window. (Switch to the window you want to 
copy if it is not the active Window.) 

2. Press the Alt/Prt Sc keys. 

For a standard application that runs outside a window, the screen con
tents are copied to the Clipboard. For a standard application that runs 
in a window, the active window is copied, as if it filled the entire 
screen, to the Clipboard. Other windows in the work area are not 
copied. 
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A block of information, 80 columns by 25 lines, is transferred from the 
selected window to the Clipboard, regardless of the number of columns 
and lines displayed in the window. 

After the information has been copied to the Clipboard, you can paste it to 
other applications with the Paste command. 

Running Large Standard Applications 

To run multiple standard applications efficiently, run the largest application 
first. 

If you run more than one application and try to run a new application that 
requires more memory than is available, MS-Windows displays the message 
"Not enough memory to run." 

If you see this message, close an application that you do not currently need 
and try to run the standard application again. 

If you are closing a standard application, you should first execute the Exit 
command of the application. 

The application runs after enough memory has been freed by closing other 
applications. If the MS-DOS Executive window is the only application run
ning, the application you selected runs because MS-Windows and the MS-DOS 
Executive application step aside and give the application most of the availa
ble memory. A small amount of memory is retained for restoring 
MS-Windows. 

When you finish using the large application, close it. After you close the 
application, the MS-DOS Executive window returns to the work area. Any 
application defined in the WIN.INI file to load or run is started. 

NOTE 
Do not use a large standard application in the WIN.lNI file's RUN= 
line. 

Running Special Applications 

Some applications remain in memory after you load them. These special 
applications are sometimes called "memory resident," "terminate and stay 
resident," or "pop-up" programs. 

You must load special applications before you start MS-Windows. 
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You run special applications from MS-DOS outside MS-Windows. You can also 
run special applications while using standard applications that both: 

• Do not run in a window 

• Have Directly Modifies Memory set in their PIFs 

You cannot run special applications from COMMAND.COM in MS-Windows. 

NOTE 
The PIF for a special application should have the Directly Modifies 
Memory option enabled. If you then try to run a special 
application, a system warning displays. Select CANCEL. If you 
select Ok, the special application can cause system problems. 

Some special applications prevent you from switching back to MS-Windows. 
To return to MS-Windows, stop the special application by using its EXIT 
command. 
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After MS-Windows is set up, you can add a printer driver file to MS-Windows 
when you want to install: 

• An existing printer driver file 

The printer driver file is included in the network directory 
H:\ WIN\UTIL, which stores printer driver files. 

• A new printer driver file 

The printer driver file is not in the network directory H:\ WIN\UTIL. 
You install the printer driver file by copying it from the distribution 
diskette of a new application to the network directory H:\ WIN\UTIL. 

After you add a new printer to your system, you must let MS-Windows know 
which communications port the printer is connected to before you can use 
the printer. To define the communications port, use the Connections com
mand in the Setup menu of the Control Panel. 

Adding an Existing Printer Driver File 

To add an already existing printer driver file to your system: 

1. Select the Add New Printer command from the Installation menu. 

MS-Windows displays the Add Printer dialog box. Figure 8-4 shows the 
Add New Printer dialog box. 

Add Printer 
Insert the disk ~ith the printer file 
you ~ish to add into driue A. or choose 
an alternatiue driue/directory: 
IlIa'UIU.'.II .. 

( Ok ) (Cancel) 

Figure 8-4 Add Printer Dialog Box 

2. In the text box, you type the location of the printer driver file, 
typically: 

H:\WIN\UTIL 
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3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available in the 
directory you specify. 

4. From the list box, select a printer. 

The name of the corresponding printer driver file is displayed in the 
Printer File text box of the dialog box. 

See Table 8-1 for information on selecting the LA75 and the LN03 PLUS 
printers. 

5. Select the Add command button. 

MS-Windows displays a dialog box. 

6. Select the No command button. 

Selecting the No command button is the normal procedure. However, if 
you want to duplicate this printer driver file, type the drive or name of 
an existing directory you want, and select the Yes command button. 

MS-Windows updates the WIN.INI file to include information for the 
new printer driver. However, only the WIN.INI file used when you start 
MS-Windows is updated. If the printer is added to the network and is 
used by more than one user, the WIN.INI file of each user needs to be 
updated. 

Table 8-1 Selecting Printers 

Type of Printer 

LA75 

LN03 PLUS with CG-Times Cartridge 

LN03 PLUS with ISO/PC Cartridge 

LA75 to emulate IBM Proprinter 

LN03 PLUS with ISO/PC Cartridge to 

emulate IBM Proprinter 

8-8 

Select 

Digital LA75DEC 
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LA75STD 
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LA50.DRV 

LN03PLUS.DRV 
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LA75.DRV 
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Adding a New Printer Driver File 

Your system administrator adds new printer driver files from the distribution 
diskette that comes with a new printer. This section includes information 
your system administrator needs to add a new printer driver file. 

To add a new printer driver file to the directory containing the other 
MS-Windows printer driver files: 

1. Select the Add New Printer command from the Installation menu. 

MS-Windows displays a dialog box that prompts you to insert into Drive 
A the diskette with the printer driver file you want to add, or to select 
an alternate drive/directory. It displays H:\ WIN\UTIL in the text box. 
Select Drive A by typing in the text box: 

A:\ 

2. Insert the diskette with the printer files. 

See the printer hardware documentation to determine which diskette 
and which directory contains the printer driver files (.DRV). 

3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available on the 
diskette. 

4. From the list box, select a printer. 

After you select a printer, the name of the corresponding printer driver 
file displays in the printer file text box at the right. 

S. Select the Add command button. 

A dialog box prompts you for the name of the drive or directory to 
which you want to copy the printer driver file. 

6. In the text box, type the alias for H:\ WIN\UTIL, the drive and directory 
to which the printer driver file is to be copied. Drive H: must be 
connected to the read/write alias for the system files. 

7. Select the Yes command button. 

MS-Windows updates the WIN.INI file to include information for the 
new printer driver. However, only the WIN.INI file used by 
MS-Windows when you started MS-Windows is updated. If the printer is 
added to the network, and is used by more than one user, the WIN.INI 
file of each user needs to be updated. 
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Removing a Printer 

To remove a printer from MS-Windows: 

1. Select the Delete Printer command from the Installation menu. 

MS-Windows displays the Delete Printer dialog box. The list box shows 
all the printers currently in your WIN.INI file. Figure 8-5 shows the 
Delete Printer dialog box. 

Delete Printer 

LHIJ3DEC LPT3: 

Printer File: .. LASII.DRU 

( Delete) ( Cancel ) 

Figure 8-5 Delete Printer Dialog Box 

2. Select the printer you want to remove from the list box. 

The file name of the corresponding printer driver file is displayed in 
the text box. 

3. Select the Delete command button. 

MS-Windows displays a dialog box. 

4. Select the No command button. 

8-10 

NOTE 
When you select the No command button, the printer name is 
deleted from the WIN .INI file, but the printer driver file is not. By 
selecting the No command button, you can use the procedure 
discussed in "Adding an Existing Printer Driver File," because the 
printer driver is still stored in the directory. 
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It is recommended that you do not delete the printer driver file. If 
you select the Ok command button, the printer driver file is 
deleted from the network directory H:\ WIN\UTIL. To add the 
printer driver file again, you must follow the more complicated 
procedure discussed in "Adding a New Printer Driver File." 

IIIII 

Some printer drivers support more than one printer model. In this case, the 
printers share the print driver file. If other printers share the printer driver 
file that is displayed in the Delete Printer dialog box, that printer driver file 
is not deleted, because it is still used by the other printers. 

In this case, MS-Windows displays a dialog box, indicating the shared printer 
driver file is not deleted. However, it is disassociated from the selected 
printer in the WIN.INI file. 

Adding a New Font 

To add a font file (.FON) to MS-Windows, use the Add New Font command 
from the Installation menu. This command works similarly to the Add New 
Printer command. 

When you select the Add New Font command (or the Delete Font command), 
you must specify where the font files are located. MS-Windows lists the avail
able fonts, including the font names, the font sizes, and the set numbers. 

The set number is based on the devices that the font is primarily designed to 
be used with. 

Set 1 

Set 1 fonts are stroke fonts. They can be used for the screen, a printer, or a 
plotter device of any resolution. 

Set 2 

Set 2 fonts are raster fonts. They are designed for a screen resolution of 640 
X 200, such as a workstation with the IBM Color Graphics Adapter or com
patible adapter card. 
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Set 3 

Set 3 fonts are raster fonts. They are designed primarily for a screen resolu
tion of 640 X 350, such as a workstation with an IBM Enhanced Color 
Graphics Adapter or Hercules Graphics Card. These fonts are also used by 
VAXmate. 

Set 4 

Set 4 fonts are raster fonts. They are designed primarily for printers in 60 dpi 
resolution: 

• IA75 in STD mode (landscape mode) 

• Okidata 92, 93, 192, 193, standard models (portrait mode) 

• Okidata 92, 93, 192, 193, standard and IBM-compatible models (land-
scape mode) 

• Epson MX-BO, FX-BO, and compatibles (landscape mode) 

• IBM Graphics (landscape mode) 

• IBM Proprinter (landscape mode) 

• Star Micronics SG-10 (landscape mode) 

Set 5 

Set 5 fonts are raster fonts. They are designed for printers in the 120 dpi 
resolution: 

• IA75 in STD mode (portrait mode) 

• Okidata 92, 93, 192, 193, IBM-compatible models (portrait mode) 

• Epson MX-BO, FX-BO, and compatibles (portrait mode) 

• IBM Graphics (portrait mode) 

• IBM Proprinter (portrait mode) 

• Star Micronics SG-10 (portrait mode) 

In addition to these fonts, an application can list device fonts. These are the 
fonts provided by a device. For example, on print-wheel printers, font names 
correspond to wheel names. These fonts cannot be added or deleted with the 
Control Panel, but they can be listed when the output device is selected. 
When a raster font does not correspond to the screen, MS-Windows can sub-
stitute a screen font in the same class. ( " 

\._-" 
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NOTE 
Because applications handle fonts differently, some applications 
may not list all fonts. 

Fonts have names that represent their different characteristics. Table 8-2 lists 
and describes the fonts that are included on H: \ WIN\ UTIL. 

Table 8-2 Fonts on the Fonts Disk 

Font 

DECterm 

Relv 

Courier 

TmsRmn 

Roman 

Modern 

Script 

Description 

(Raster font.) A fixed-width font (characters having uniform widths) 
without serifs. 

(Raster font.) A proportional font (characters having varying widths) 
without serifs. 

(Raster font.) A fixed-width font with serifs. 

(Raster font.) A proportional font with serifs. 

(Stroke font.) A proportional font with serifs. 

(Stroke font.) A proportional font without serifs. 

(Stroke font.) A proportional font of slanted characters formed from 
nearly continuous curved lines. 

Table 8-3 describes the fonts that are not included on H:\ WIN\UTIL, but you 
can see them in some applications. These fonts cannot be added or deleted. 

Table 8-3 Fonts Not on the Fonts Disk 

Font Description 

System (Raster font.) A fixed-width font designed for the screen. 

Terminal (Raster font.) A fixed-width font that is the same as the font your work
station displays from MS-DOS. 

Deleting a Font 

To delete a font file to MS-Windows, use the Delete Font command from the 
Installation menu. This command works similarly to the Delete Printer 
command. 
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Using the Setup Menu 

The Setup menu has four commands: 

• Connections, which lets you assign or change printer pon connections 

• Printer, which lets you select the default printer 

• Communications Port, which lets you select a serial communications 
pon and select parameters, such as baud rate, word length, parity, and 
stop bits 

• Network Terminal Services, which lets you select network services for 
your communication ports 

Figure 8-6 shows the Setup menu commands. 

Pr:i,nh:'(' _, _, • 
Communications Port ... 
Ne work Terminal Services ... 

Figure 8-6 Setup Menu Commands 

Changing Printer Connections 

MS-Windows needs to know to which communications pon your printer is 
connected. To set or change the port for your printers, use the Connections 
command. 

For example, to move your printer from the communications pon LPTI to 
LPT2, use the Control Panel to change the printer connections setting. 
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To change printer connections: 

1. Select the Connections command from the Setup menu. MS-Windows 
displays the Connections dialog box. Figure 8-7 shows the Connections 
dialog box. 

Printer Connection 

LHUJDEC LPT3: 

( Ok ) (Cancel ) 

Figure 8-7 Connections Dialog Box 

2. From the Printer list box, select the printer you want to change. The 
current communications port assignment for the selected printer is 
displayed in the Connection list box, located at the right. 

3. From the Connections list box, select one of the communications ports. 

4. Select the Ok command button. 

NOTE 
You can redirect an LPT port only to the SPP (Serial Printer Port) 
or to a network print device. 

Changing the Default Printer 

When you execute a Print command, MS-Windows prints the file on the 
default printer. To select the default printer and to set its output modes, use 
the Printer command. 

Printer output modes are printer-specific settings, such as portrait mode 
(normal vertical page orientation) or landscape mode (horizontal page orien
tation). The Printer command is useful when you have both local and remote 
printers, or both dot matrix and character printers, connected to your com
munications ports. 
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To change the default printer: 

1. Select the Printer command from the Setup menu. 

MS-Windows displays the Default Printer dialog box. It lists all the avail
able printers and their current communications port connections. Figure 
8-8 shows the Default Printer dialog box. 

Default Printer 
I 

lHIJ3DEC lPT3: 
( Ok ) 

(Cancel ) 

Figure 8-8 Default Printer Dialog Box 

2. From the list box, select the printer name. 

3. Select the Ok command button. 

MS-Windows displays the Output Mode dialog box, containing the mode 
settings specific to the printer you selected. 

4. To select another output mode, select from the options for printer 
output or answer the questions in the dialog box. 

5. Select the Ok command button. 

The printer you select becomes the default printer. 

Changing the Communications Port 

To select COM1 and COM2 settings, including baud rate, stop bits, parity, 
word length, and the retry (print/send) option, use the Communications Port 
command. 

For example, MS-Windows' print spool uses these settings to configure the 
communication port before printing. (COM1 and COM2 are serial communi
cations ports and can be used only with serial printers and serial communica
tion deVices.) 

8-16 



( 
Using the Control Panel 11111 

To select a communications port: 

1. Select the Communications Port command from the Setup menu. 

MS-Windows displays the Communication Settings dialog box. Figure 
8-9 shows the Communications Settings dialog box. 

Co~munications Settings 

Port @~ OCOM2: 

Baud Rate: 11218 1 

Word Length 0 4 0 5 0 6 0 1 @ 8 

OEuen 

@1 

OOdd 

01.5 

@Hone 

02 
Parity 

Stop Bits 

Handshake o Hardware @ Hone 

( Ok ) (Cancel ) 

Figure 8-9 Communications Settings Dialog Box 

2. Select the communications port COM1 or COM2. 

The settings for the selected communications port are displayed in the 
dialog box. 

3. Select the rest of the settings. 

The settings for baud rate, word length, stopbits, and handshake 
(protocol) should be the same as those set for your printer or device. 
The protocol, "Hardware," is equivalent to XON/XOFF. See your 
printer or device documentation for the proper communications port 
settings. 

4. Select the Ok command button. The communications port you select is 
set up. 

NOTE 
This command does not configure or set up the communication 
hardware. It gives information about the communication hardware 
settings to MS-Windows and the applications using the 
communications ports. When you set up a communications device 
or printer, make sure the communications port settings are 
configured according to the serial communications instructions 
supplied by your printer or device manufacturer before you try to 
print. 
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Selecting Network Terminal Services 

To select terminal services for the workstation's communication ports, use 
the Network Terminal Services command. This command lets you redirect the 
COMI and COM2 communications ports to the selected terminal services. 
Any application using COMI or COM2 is redirected over the local area net
work to the specified network terminal service. 

To select a network terminal service: 

1. Select the Network Terminal Services command from the Setup menu. 

MS-Windows displays a Network Terminal Services dialog box. It lists 
the currently available network services. Figure 8-10 shows the Network 
Terminal Services dialog box. 

Network Terlllinal Services 

You can assign communications ports 1 and 2 to the services listed 
below. These are the only currently available services. Previously 
assigned services may be unavailable at this time. 

Port Services 

~mwe i I~~~~~, ~ :-AA ER l~lMktER II '. I 
1~~j~~G ~ RANGER 

( Ok ) ( Reset) (Cancel) 

Figure 8-10 Network Terminal Services Dialog Box 

NOTE 
For most systems, you can access a maximum of 10 services. A 
warning box is displayed if the service table has overflowed. 

To add more services, you must change the table size in the 
Network Terminal Services (!AT) driver. 

2. From the Port list box, select the COMI or COM2 communications port. 

The current terminal services for that port are displayed. 
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3. From the Services list box, select a terminal service. 

4. Select the Ok command button. 

You can redirect communications ports to a network terminal service for any 
standard application that runs in a window, such as, the VT220 terminal 
emulator. Using the configuration shown in Figure 8-10, you can connect the 
VT220 emulator to the COM2 port; however, all communications for the 
VT220 emulator will use the network terminal service called RANGER. For 
more information about network terminal services, see Chapter 9. 

When you run an application that uses COM1 or COM2, the selected termi
nal service is redirected if the following conditions are met: 

• The Network Terminal Service driver (LAT) was installed prior to start
ing MS-Windows. This driver lists all available services, normally 
assigned by the key diskette. 

• The redirected port is COM1 or COM2. Only COM1 and COM2 can be 
redirected. 

• The mode of transmission is computer to computer, and does not use a 
modem. Only applications that do not use modem control signals to 
control the flow of data can be redirected. 

• No more than four Network Terminal Services are active, including redi
rected and direct connections. 

• A terminal services name is present in the WIN.INI file for the serial 
communication device being used. You cannot select a terminal service 
not listed in the Services list box. 

• The terminal service is available. This availability is dynamic. If a termi
nal service is selected for a communications port, the terminal service 
is assigned to that communications port only as long as terminal service 
is available to the network. If the terminal service becomes unavailable 
to the network, it is no longer assigned to the communications port. 

NOTE 
Even if COM1 and COM2 hardware is not installed, redirection 
over the local area network can occur, because the redirection is 
done by software. 
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Using the Preferences Menu 

The Preferences menu has four commands: 

• Screen Colors, which lets you adjust shades on your screen 

• Keyboard Settings, which lets you change settings such as keyc1ick and 
autorepeat 

• Mouse, which lets you swap the function of the left and right mouse 
buttons 

• Country Settings, which lets you select country-specific user preferences 

Figure 8-11 shows the Preferences menu commands. 

Or's ••• 
Settings ... 

Figure 8-11 Preferences Menu Commands 

Changing Screen Colors 

To adjust the shades of the components in a window, use the Screen Colors 
command. These components are: 

• Window background 

• Window text 

• Scroll bars 

• Active (selected) title bar 

• Inactive (unselected) title bar 

• Title bar text 

• Window frame (the thin border around the outside of the window) 
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• Menu bar 

• Menu text 

• Screen background (including the icon area) 

To change the shade of a component in a window: 

1. Select the Screen Colors command from the Preferences menu. 

MS-Windows displays the Screen Colors dialog box. Figure 8-12 shows 
the Screen Colors dialog box. 

NOTE 
Set your screen to have contrasting text and background colors. 
Otherwise, your screen could look blank. 

Screen Colors 
I9DiliI I 

~1nd!lU !ext 
Scroll Bars 
Actiue Title Bar 
Inactiue Title Bar 

Hue 

Bright 

Color 

Salilple 
ActIve 

Figure 8-12 Screen Colors Dialog Box 

2. From the Screen Colors list box, select the part of the screen for which 
you want to change the shade. 

The current settings for Hue, Bright, and Color of the selected 
component in the window are displayed in the scroll bars. The mixture 
of these three settings for the selected component result in the current 
shade displayed in the Sample area. 

To change the shade of a component in the window, change the settings 
for Hue, Bright, and Color. 
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3. To change a setting for Hue, Bright, or Color: 

a. Move the cursor to the scroll bar by clicking on the scroll bar or by 
pressing the Tab key until the scroll box blinks in the desired scroll 
bar. 

b. Scroll to the right or to the left to change the setting. 

With the mouse, click on the arrows or drag the scroll box in the 
scroll bar. 

With the keyboard, press the right and left arrow keys to change 
settings in small increments, or press the Pg Up or Pg Dn keys to 
move across the scroll bar more quickly. 

As you scroll, the Sample area dynamically shows the changing shade 
of the selected window component. 

c. Select another scroll bar until the desired shade is displayed in the 
Sample area. 

d. Change the shades of all other items in the Screen Colors dialog box. 

e. When you finish changing screen colors, select the Ok command 
button. 

When you select the Ok command button, the settings are recorded in 
the WIN.lNI file, and the dialog box is removed from the screen. 

Changing Keyboard Settings 

To change keyboard features, use the Keyboard Settings command. These fea
tures include: 

• Keyclick volume (No sound, Soft, Intermediate, Loud) 

The default setting is Intermediate. 

• Autorepeat (enable or disable) 

The default setting is autorepeat enabled. 

• Lock selection (Caps Lock or Shift Lock) 

The default setting is Caps Lock. 

This selects the function of the Lock key. 
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Scrolling in the Emulator Window 

If you need to view more information than can be displayed in an emulator 
window, use these keys: 

( Ctrl/Find ) 

( Ctrl/Select ) 

( Ctrl/Prev ) 

( Ctrl/Next ) 

To scroll to the left 

To scroll to the right 

To scroll up 

To scroll down 

Using the VT220 Emulator System Menu Commands 

The VT220 emulator adds the following commands to the standard System 
menu commands: 

• Set-Up 

• Mark 

• Copy 

• Paste 

• About 

The Set-Up Command 

IIIII 

You can start or exit from the VT220 emulator Set-Up utility by selecting the 
Set-Up command. Chapter 12 discusses the Set-Up utility. 
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The Mark, Copy, and Paste Commands 

The VT220 emulator lets you transfer information between itself and the 
MS-Windows Clipboard application. You copy the information from the emu
lator to the Clipboard or paste information from the Clipboard to the emula
tor as if you typed it. When you send information to the Clipboard, the 
characters are interpreted as ISO Latin-l characters. 

To copy text to the Clipboard: 

1. Select Mark from the VT220 System menu. 

The word "Mark" is displayed in parentheses next to the VT220 
emulator title in the title bar. A special vertical bar, the insertion point, 
is also displayed in the window. 

2. Drag the insertion point across the text you want to copy. This marks 
the text. 

3. Select Copy to move the marked text to the Clipboard. 

NOTE 
Marking is disabled whenever a key is typed, or when Mark is 
selected a second time. 

You can paste from the Clipboard at any time. The pasted text is sent to the 
host. Text is not displayed in the window unless the host echoes it, or Local 
Echo is enabled in Set-Up. 

The About Command 

The About command displays the version number of the VT220 emulator 
application. 

Leaving the VT220 Emulator 

To leave the VT220 emulator select one of the following commands from the 
VT220 System menu: 

• The Icon command 

Selecting the Icon command shrinks the VT220 emulator to an icon 
without exiting from the emulator application. 

• The Close command 

Selecting the Close command exits you from the VT220 emulator. 
Before using this command, you should log off the host system. 
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Table 12-4 VT220 Display Set-Up (cont.) 

Selection 

Text Cursor 

Visible 
(default) 

Invisible 

Auto Wrap 

On 

Off 
(default) 

Cursor Style 

Block 
(default) 

Underline 

Background 

Light 
(default) 

Dark 

Blink 

Font Size 

Function 

Selects whether to display a text cursor. 

Displays the cursor. 

Does not display the cursor. 

Selects whether text automatically wraps on the screen. 

Causes characters that reach the right margin to automatical
ly be displayed in the first character position of the next 
line. 

Causes characters that go beyond the right margin to over
write the last character position of the current line. 

Selects the text cursor style. 

Displays block cursor. 

Displays underline cursor. 

Selects the screen display type. 

Selects reverse video screen display (dark text on a light 
background) . 

Selects a dark screen display (light text on a dark back
ground). 

Blinking display is not implemented for the VT220 emulator. 

You have a choice of displaying characters with blinking at· 
tributes as either normal video (default), reverse video, or 
underscore. 

Changes the font size of characters displayed on the screen. 
The settings are: Normal (default), Small, or Automatic. 

If you are using applications that display more than 80 col
umns, use the Automatic or Small setting. 
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IIIII Using Set-Up With the VT220 Emulator 

General Screen 

The General Set-Up screen lets you define a group of commonly used general 
operating settings. 

Receiue File: Idle 
Send File: Idle 

Printer: Hone 
Moden: Hot Selected 

Terninal Enulation 
r(!rm:inil.l 11) 
User Defined Keys 
User Features 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Connunications: Conn Port 1 - Data Leads Only 

Screen 12-5 VT220 General 

Table 12-5 defines the General Set-Up selections and, where applicable, the 
settings. 
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Saving Changes 

To save changes to the current file, use the Save command from the File 
menu. 

Calendar replaces the file on the disk with the current file. 

Printing Appointments 

To print appointments: 

1. Select the Print command from the File menu. 

Calendar displays the Print dialog box. Figure 20-5 shows the Print dia
log box. 

Print Appointments 

Fro ... : 1,,, .. .£r4 ( Ok ) 
To: ( Cancel) 

Figure 20-5 Print Dialog Box 

2. In the From text box, type the first date you want to print. 

3. Press the Tab key to move the cursor to the To text box. 

4. Type the last date you want to print. 

To print a single date's appointments, leave the To text box blank. 

5. Select the Ok command button. 

Calendar prints the text for the selected dates. 
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Removing Appointment Dates 

You can delete a single date or a range of dates to make room for other dates 
on your disk. 

To remove appointment dates: 

1. Select the Remove command from the File menu. 

Calendar displays the Remove dialog box. Figure 20-6 shows the 
Remove dialog box. 

ReMove AppointMents 

FroM: 1!.II.BlIl 1 I Ok ) 

To: '---_----'I ( Cancel ) 

Figure 20-6 Remove Dialog Box 

2. In the From text box, type the first date you want to remove. 

3. In the To text box, type the last date you want to remove. 

To remove a single date's appointments, leave the To text box blank. 

4. Select the Ok command button. 

Calendar removes the text for the dates you selected. 

Deleting a File 

You can delete a file to make room for other files on your disk. To delete a 
file, use the Delete command from the File menu. 
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Table A-2 Valid Compose Sequences (cont.) 

Character 

« (angle quotes left) 

» (angle quote right) 

NBSP (No Break Space) • 

j (inverted !) 

i., (inverted ?) 

o (degree sign) 

© (copyright sign) 

® (reg. trademark) • 

¢ (cent sign) 

£ (pound sign) 

" (general currency) 

¥ (yen sign) 

- (soft hyphen) • 

.. (macron sign) • 

IL (micro sign) 

., (logical NOT sign) 

± (plus/minus sign) 

X (multiply sign) 

7 (divide sign) 

I (superscript 1) 

2 (superscript 2) 

3 (superscript 3) 

~ (paragraph sign) 

§ (section sign) 

!! (feminine ordinal) 

Q (masculine ordinal) 

• (middle dot) 

Two-Key 
Sequence 

Creating Alternate Characters IIIII 

Three-Key Sequence 

« 

» 

(sp)(sp) (Two spaces) 

!! 

?? 

0/\ or • (sp) 

co 

ro 

c/ or cI 

1- or 1= 

xo 

y- or y= 

_/\ or-/\ 

/u 

-, (order sensitive) 

+-

xx 

-: (order sensitive) 

1/\ 

2/\ 

3/\ 

!p 

so or s! 

1\ 
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('\ 

Table A-2 Valid Compose Sequences (cont.) 
l_~ 

Two-Key 
Character Sequence Three-Key Sequence 

Ij4 (fraction one-quarter) 14 (order sensitive) 

1/2 (fraction one-half) 12 (order sensitive) 

3/4 (fraction three-quarters) • 34 (order sensitive) 

B (German sharp s) ss 

e (cap Icelandic Eth) • -0 

0 (sm Icelandic Eth) • -d 

(/> (0 slash) 0/ 

~ (0 slash) 0/ 

p (cap Icelandic Thorn) • TH (order sensitive) 

p (sm Icelandic Thorn) • th (order sensitive) 

- (tilde character) - (sp) - (sp) 

· (grave accent) , (sp) . (sp) 

· (apostrophe) , (sp) - (sp) 

- (acute accent) • 

A (circumflex character) " (sp) A (sp) 

II (double quote) II (sp) dieresis (sp) 

.. (dieresis) • . ... 
• (cedilla) • 

A (A grave) 'A A' 

it (a grave) 'a a' 

A (A acute) 'A A' 

a (a acute) 'a a' 

A (A circumflex) "A A" 

a (a circumflex) "a a" 

A (A tilde) -A A-

a (a tilde) -a a-
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Table A-2 Valid Compose Sequences (cont.) 

Two-Key 
Character Sequence Three-Key Sequence 

A (A umlaut) OIA AOI 

a (a umlaut) OIa aOl 

A (A ring) 'A or °A A' or AO (degree sign) 

a (a ring) 'a or °a a' or aO (degree sign) 

.£ (AE ligature) AE (order sensitive) 

:e (ae ligature) ae (order sensitive) 

(: (C cedilla) ,C C, 

~ (c cedilla) ,c c, 

Il (E grave) 'E E' 

e (e grave) 'e e' 

E (E acute) 'E E' 

e (e acute) 'e e' 

( E (E circumflex) /\E E/\ 

e (e circumflex) /\e e/\ 

E (E umlaut) OlE EOI 

e (e umlaut) Ole eOl 

i (I grave) 'I I' 

i (i grave) 'i i' 

i (I acute) 'I I' 

i (i acute) 'i i' 

I (I circumflex) /\1 1/\ 

i (i circumflex) /\i i/\ 

r (I umlaut) 011 101 

1 (i umlaut) IIi ill 

N (N tilde) -N N-

fi (n tilde) -n n-

(, 
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,r-\ 

Table A-2 Valid Compose Sequences (cont.) 
~) 

Two-Key 
Character Sequence Three-Key Sequence 

o (0 grave) '0 0' 

<> (0 grave) '0 0' 

6 (0 acute) '0 0' 

<> (0 acute) '0 0' 

6 (0 circumflex) /\0 0/\ 

(, (0 circumflex) /\0 0/\ 

(5 (0 tilde) -0 0-

o (0 tilde) -0 0-

o (0 umlaut) "0 0" 

0(0 umlaut) "0 0" 

ill (OE ligature) .. OE 
(order sensitive) 

re (oe ligature) .. oe ( 

(order sensitive) 
~ _,7' 

iJ (U grave) 'U U' 

u (u grave) 'u u' 

U (U acute) 'U U' 

u (u acute) 'u u' 

U (U circumflex) /\U U/\ 

'u (u circumflex) /\u u/\ 

U (U umlaut) "U U" 

ii (u umlaut) "u u" 

Y (Yacute) • 'Y Y' 

Y (yacute) • 'y y' 

Y (Y umlaut) .. "Y Y" 

Y (y umlaut) "y y" 
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Information About the WIN.INI File \\\\\ 

CursorBlinkRate=speed 

Sets the speed in milliseconds for the cursor blinking action. Speed can 
be 0 to 65535 ms. 

programs=list 

Specifies the files displayed in the MS-DOS Executive window when you 
select the Programs command from the View menu. The list contains 
the file extensions without the period. Separate the file extensions with 
spaces. 

NullPort=port 

Defines the name for the null port to a specified port. The Control 
Panel, Spooler, and other applications use this port when an output 
device is installed, but is not connected to any port. 

load=list 

Starts the specified applications as icons when you start MS-Windows. 
The list contains the application file names as they are displayed in the 
MS-DOS Executive window without the file extension. (For example, 
Calculator is CALC, because CALC.EXE is the application file name.) 
Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

To start the MS-DOS Executive window as an icon when you first start 
MS-Windows, you must specify another application to start in a window. 
Use run= to start an application in a window and to start the 
MS-Executive window as an icon. 

You can also start an application as an icon and open a file for that 
application by adding the file name and the file extension to the load 
setting. 

To use this option, you must define the application in the Extensions 
section of the WIN.INI file. 

For example, DOTHIS.TXT starts Notepad because .TXT is in the Exten
sions section, starting the Notepad application. 
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run=list 

Stans the specified applications in windows when you stan 
MS-Windows. You list the file names exactly as they are displayed in the 
MS-DOS Executive window without the file extension. 

When you specify an application to stan in a window when you stan 
MS-Windows, the MS-Executive window automatically stans as an icon. 

Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

You should not specify a file name either for a special application or 
for an application that uses a large amount of memory; otherwise, you 
will enter an endless loop when you exit from the application. 

You can arrange windows by using spaces to designate windows within 
the same column, and commas to designate a new column. 

You (:an stan an application and open a data or text file in a window 
when you stan MS-Windows by adding the file name and the file exten
sion in the run setting. To use this option, you must define the applica
tion in the Extensions section of the WIN.INI file. 

device=name,driver,port 

Defines the default printer (or plotter): 

name 

driver 

pon 

Is the name of the default device. You must also specify 
this default device in the Devices section. 

Is the file containing the device's printer file name with-
out the file extension. 

Is the pon to which the device is connected. You must 
also specify this pon in the Pons section. 

SwapMouseButtons=setting 

B-6 

Swaps the functions performed by the left and right mouse buttons. 
Setting can be: 

No The left mouse button controls the mouse functions. This is 
the default. 

Yes The right mouse button controls the mouse functions. 
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In/ormation About the WIN.INI File IIIII 
Windows Section Example 

The following Windows section: 

• Enables the spooler when printing. 

• Sets the mouse double-click speed to 900 ms. 

• Sets the cursor blink rate to 550 ms . 

• Specifies that files with the .COM, .EXE, and .BAT file extensions are 
displayed in the MS-DOS Executive window when you use the Programs 
command. 

• Specifies None as the null port. 

• Using no file specifications, starts Notepad and Calculator as icons, and 
starts Notepad with the text file ONGOING.TXT. 

• Starts Clock in the first window of the first column, Calculator in the 
second window of the first column, Notepad in the first window of the 
second column, and Notepad with the file specification 
K:\MEMOS\ONGOING.TXT in the second window of the second 
column. 

• Sets the default printer to a DIGITAL LA7S, which is connected to the 
LPTl: port. 

• Does not switch the left and right mouse buttons. 

Example 

[windoW5] 
5pooler=ye5 
DoubleClickSpeed=900 
Cur50r81inkRate=550 
program=com exe bat 
liullPort=lione 
load=notepad calc ongoing. txt 
run=clock calc,notepad K:\memo5\ongoing.txt 
device=LA75DEC,LA75,LPT1: 
SwapMou5e8utton5=lio 
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Extensions Section 

Purpose 

In the Extensions section, you can specify file extensions that let you start an 
application and open a file in a single operation. When you select a file with 
the specified extension, MS-Windows starts the application and opens the file 
in one step. 

NOTE 
To change the Extensions section, use the Notepad application. 

Format 

[extensions] 

extension=application[parameter] 

Where: 

extension 

application 

parameter 

B-8 

Is the file extension that starts the application. 

Is the name of the application that is started. You must in
clude the application's extension (.EXE). 

Is the name and extension of the file (optional) for the ap
plication to open. You can use a caret C) to represent any 
file with that extension (for example, A.TXT). Then you can 
select any file with the specified extension, and MS-Windows 
starts the application with that file. 

c 
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In/ormation About the WIN.INI File IIIII 
Extensions Section Example 

The following Extensions section: 

• Starts the Notepad application when you specify a file containing a .TXT 
file extension. Notepad opens the file. 

• Starts the Notepad application when you specify a file containing an 
.INI file extension. Notepad opens the file . 

• Starts the MS-Paint application when you specify a file containing an 
.MSP file extension. Paint opens the file. 

Example 

[extensions] 
txt=notepad.exe A.txt 
tni=notepad.exe A.ini 
msp=paint.exe A. msp 
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Colors Section 

Purpose 

The Colors section specifies the shading for various components of the 
MS-Windows screen. 

NOTE 
To change the Colors section, use the Control Panel. Set your 
screen to have contrasting text and background colors. Otherwise, 
your screen could look blank. 

Format 

[color!;] 

component=redvalue greenvalue bluevalue 

Where: 

component 

Specifies the component of the MS-Windows screen. The component 
can be: 

B-IO 

Window 

WindowText 

Scrollbar 

ActiveTitle 

InactiveTitle 

TitleText 

WindowFrame 

Menu 

MenuText 

Background 

Is the nontextual background of the window 
work area. 

Is the textual display in the window work area. 

Is the scroll bar. 

Is the background of the active title bar. 

Is the background of the inactive title bar. 

Is the application title's text. 

Is the set of lines that form the frame of the win
dow and the nontextual part of the application's 
title background. 

Is the nontextual background of the menu area. 

Is the textual display in the menu area. 

Is the icon area and screen background. 
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PIP Section Example 

The following PIF section: 

• Sets the swap disk to the default. 

• Sets the swap size to the default. 

• Creates a program information entry for COMMAND.COM with a 32K 
byte memory requirement. 

Example 

[pif] 

swapdisk=? 
swapsize=O 
command.com=32 
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Ports Section 

Purpose 

The Ports section lists the available communication ports for a workstation 
and defines the default modes or settings. The Ports section can include up 
to eight entries. 

NOTE 
To change the Ports section, use the Control Panel. 

Format 

[port5] 

port:=baudrate,parity,wordlength,5topbit5,[retry] 

filename.PRH= 

Where: 

port: 

Is the name of the available port. Port can be LPTl:, LPT2:, LPT3:, 
COMl:, or COM2:. 

If the port is COM1: or COM2:, you must specify in order the: 
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baud rate 

parity 

word length 

stop bits 

retry 

Is the port's baud rate. 

Is the parity setting: 0 (odd), e (even), or 
n (none). 

Is the length of a word, in bits. 

Is the number of stop bits. 

Controls continuous retry on a timeout. This op
tion is used if the port is used only for a serial 
printer. If you leave this option blank, the cur
rent setting does not change. 

The retry options are: 

p which enables continuous retry on a timout 

which disables continous retry on a timeout 



( 

( 

( 

Information About the WIN.INI File IIIII 

Declnjo Section Example 

The following DecInfo section: 

• Defines the location of the on-line Information System data files as drive 
H in the DECAPP subdirectory. 

• Defines the name of database as INFOUSER. 

• Defines the location of your specific information regarding the on-line 
Information System as drive I. 

Example 

[Declnfo1 
DBpath=H:\DECAPP 
DBname=INFOUSER 
BMpath-I:\ 
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Devices Section 

Purpose 

The Devices section identifies a workstation's output devices, the printer 
files, and the port connections. 

NOTE 
To change the Devices section, use the Control Panel. 

Format 

[device51 
device=driver,port[,portl 

Where: 

device Is the name of the output device where: 

driver 

port 

Is the file name of the device's printer driver. 

Is the name of the communication port or print file to 
which the device is connected (optional). Port can be 
LPTl, LPT2, LPT3, COMl, or COM2. If a device is not 
currently connected, the port should be the port speci
fied in the NullPort setting of the Windows section. 

Devices Section Example 

• Defines the DIGITAL LN03 printer as connected to the null port and to 
the LPT3 :communication port. 

• Defines the IA75DEC printer as connected to the LPTI :communication 
port. 

• Defines the IBM Graphics printer as the null port. 

Example 

[device51 
Digital LH03=LH03,Hone,LPT3: 
LA75DEC=LA50,LPT1: 
IBM Graphic5=IBMGRX,Hone 
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Fonts Section 

Purpose 

The Fonts section identifies one or more font types that MS-Windows applica
tions can use for display. 

NOTE 
To change the Fonts section, use the Control Panel. 

Format 

[font5] 
fontname=fontfile 

Where: 

fontname Is the descriptive name of a font. The fontfile is the name of 
the file containing the font resources. Do not use the file 
extension. 

Fonts Section Example 

The following Fonts section: 

• Defines the Courier font. 

• Defines the Helvetica font. 

Example 

[font5] 
Courier 8,10,12 (Set #3)=CDURC 
Helv 8,10,12(Set#3)=HELVC 
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Appendix C 
Program 

Information Files 

This appendix describes how to: 

• Use Program Information Files (PIFs) 

• Use the PIF editor 

• Select PIF options 

• Use default settings 

• Decide what to put in a PIF 

• Change PIFs 

• Give applications more memory 

Using Program Information Files 

A program information file (PIF) is a file that contains information about a 
standard application. It has the file extension .PIF. When you run a standard 
application, MS-Windows looks for a PIF to configure the application. 

PIFs for most popular standard applications are included with your 
MS-Windows software package. During setup, the Installation Aide installs 
PIFs in the PIF subdirectory to establish a PIF library. You probably will not 
enter information into a PIF unless you use a standard application that does 
not have a PIF. 
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NOTE 
If you try to run a standard application that does not have a PIF, 
MS-Windows automatically uses a set of default application 
characteristics. MS-Windows displays a dialog box asking if it 
should "Continue with default settings." You should create a PIF, 
using the correct values from your application documentation. 

If you run an application by selecting the file name of the application (files 
that have the file extension .EXE, .COM, or .BAT), the PIF must have the 
same file name and the file extension .PIF. For example, if you use dBASE II, 
its application file name is DBASE.EXE, and its PIF must be DBASE.PIF. 

You can also run an application by selecting its PIF in the MS-DOS Executive 
window. This automatically loads and runs the application named in the PIF. 
In this case, the PIF does not have to have the same file name as the 
application. 

The preferred method is to run a standard application by selecting its PIF. 
This allows you to have customized PIFs, which are several PIFs containing 
different settings for the same application. Therefore, you can customize an 
application to the needs of different users, each with their own specific 
MS-Windows environment. 

For example, one version, APPLARGE.PIF, may need a large amount of mem
ory for those that use all of its features, and a second version, APPSMALL.PIF, 
may need less memory for those who use only a few of its features. 

Additionally, each user can have customized values for the Program Parame
ters or Initial Directory fields in their PIFs. Customized PIFs must be in the 
user's personal directory. 

The PIF must be in your directory or in your path. It should be copied from 
the PIF subdirectory to the directory from which you run the application. 
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In some cases, different applications use the same file name to start up. 
Therefore, some PIFs can have names that differ from their applications. If 
you are not sure which application a PIF works with, run the PIF editor and 
open the PIF to see which application the PIF was designed for, then copy 
the PIF to the appropriate drive and directory, and rename the file. 

Some applications can have more than one .EXE, .COM, or .BAT file on their 
disk. You need a separate PIF for each file. 

Using the PIF Editor 

To create or edit a PIF, use the PIF editor. For example, you can change the 
application settings to increase the amount of memory available to the appli
cation or to set its initial directory. 

To get on-line help about using the PIF editor: 

1. Select the About command from the System menu. 

A dialog box is displayed that lists topics about PIFs. 

2. Select a topic from the list box. 

3. Select the Help command button. 

Information about the selected topic is displayed in the. dialog box. You 
may need to scroll to see all the information. 

By using the command buttons in the dialog box, you can obtain infor
mation about other PIF topics. 

When you finish using the PIF help feature, select the Cancel command 
button. 
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Creating a PIF 

To create a new PIF: 

1. Use the Run command in the MS-DOS Executive window to start the PIF 
editor application. The file name of the PIF editor is PIFEDIT.EXE. 

The Program Information Editor window is displayed. Screen C-l shows 
the Program Information Editor window. 

-
File 

Progralll Hallie: 

Progralll Title: 

Progralll Parallleters: 

Initial Directory: 

Melllory Requirelllents: 
Directly Modifies 

Progralll Switch 
Screen Exchange 
Close Window on exit 

iji.iji"y,m,.'p,,€,.,n,Mlin •. J 

~ KB Required ~ KB Desired 
[SJ Screen 0 COM1 0 Melllory 

I~ 

o Keyboard 0 COM2 
a Preuent @ Text 
a Hone @Text 

a Graphics/Multiple Text 
a Graphics/Text 

o 

Screen C-I Program Information Editor Window 

2. Type the file name of the application to be associated with the PIF in 
the Program Name text box. Include the file extension (.EXE, .COM, or 
.BAT). 

3. Select the options or values that apply to the application. (For more 
information, see the section "Selecting PIF Options" in this appendix.) 

4. Select the Save command from the File Menu to save the new PIF. 
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To create another PIF, select the New command from the File Menu to reset 
the PIF editor screen. 

Editing PIFs 

To edit an existing PIF: 

1. Use the Run command in the MS-DOS Executive window to start the PIF 
editor. The file name of the PIF editor is PIFEDIT.EXE. 

2. Select the Open command from the File Menu. 

3. Select the PIF you want to change from the list box or type the name of 
the PIF in the text box. 

4. Select the Open button. 

5. Make the desired changes by selecting the PIF options you want. 

6. Select the Save command from the File Menu to save the changes. 

Selecting PIF Options 

PIF options are organized into these categories: 

• Program Name 

• Program Title 

• Program Parameters 

• Initial Directory 

• Memory Requirements 

• Directly Modifies 

• Program Switch 

• Screen Exchange 

• Close Window on exit 
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Program Name 

Every application (program) must have a file name assigned. 

Type the path and file name of the application, including the file extension 
.EXE, .BAT, or .COM. For example, DBASE.COM is a file for the application 
DBASE. What you enter is displayed in the MS-DOS Executive window 
directory. 

Program Title 

You can enter a descriptive title for the application to help the user identify 
it on the screen. 

What you enter is displayed in the title bar of the window, if the application 
runs in a window. This same title is also displayed above the icon of the 
application when you highlight the icon in the icon area. 

NOTE 
The PIF editor lets you enter 37 characters in the text box; 
however, only 29 characters are displayed in the title box. 

Program Parameters 

The Program Parameters option lets you pass information to an application 
when you start it. In the Program Parameters text box, you can type either of 
the following: 

• Question mark 

If you type a question mark, MS-Windows displays a dialog box when 
you start the application. The dialog box prompts you for application 
parameters. You can enter up to 126 characters in the dialog box; how
ever, the application interprets no more than 126 characters. If you 
enter more than 126 characters, MS-Windows does not beep to indicate 
an error. 

• SpeCific program parameters 

If you type specific parameters, those application parameter values are 
used every time the application is started. You can enter up to 37 char
acters in the Program Parameters text box. 

You should not redirect input and output or use piping. 

If your application requires no parameters, or if you are uncertain, leave this 
option blank. 
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Initial Directory 

If you have several directories, this option changes to a specific directory 
when the application starts. 

Type the drive and directory you want MS-Windows to change to when you 
start the application. This directory is usually the location of the applica
tion's data files. 

You can use the Initial Directory field and the Program Name field to make a 
customized PIF for applications shared on a file server. In the Program Name 
field, enter the drive and directory of the application. In the Initial Directory 
field, enter the drive and name of your personal directory. (Complete the 
other PIF fields as needed.) Make sure this customized PIF is in your per
sonal directory. 

When you select the customized PIF to run an application, MS-Windows cop
ies the application from its drive and directory and starts it in your personal 
directory where the data files are. The application can then use the data files. 
When you close the application, the updated data files remain in your per
sonal directory. 

If the data files are in the same directory as the application, leave this option 
blank. In this case, MS-Windows does not change the directory when you 
start the application. 
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Memory Requirements 

Two fields for Memory Requirements allocate memory for your applications: 

• KB Required 

Type the minimum amount of memory required (in kilobytes) by your 
application. 

Memory requirements for your application should be in the application 
documentation. 

If you do not know how much memory is required, use the default 
setting of 52K bytes. 

If MS-Windows cannot provide the specified amount of memory, and if 
no application is running other than the MS-DOS Executive application, 
MS-Windows reduces its space requirements so that the application has 
room to operate. In this case, you cannot switch back to MS-Windows 
with the Alt/Tab keys; you must execute the application's Exit com
mand, or its equivalent, to return to MS-Windows. 

• KB Desired 

C-B 

Type the maximum amount of memory your application can use. Some 
applications run better if you assign more memory. 

The value entered in this field should at least equal the value entered in 
the KB Required field. If the application allocates memory, you should 
increase the value in the KB Desired field, and you may also need to 
increase the value in the KB Required field. 

If you enter zero (0), MS-Windows allocates all available MS-Windows 
memory to the application. 

If you leave this field blank, MS-Windows uses the default setting of 
52K bytes. 

CAUTION 
You should not run the CHKDSK (Check Disk) utility program 
from MS-Windows; otherwise, it can provide invalid messages 
about memory availability. If you select the IF qualifier of 
CHKDSK, you can destroy all data stored on your workstation 
network disk. 
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Directly Modifies 

Some applications use workstation resources such that applications cannot 
share them. Select any options that apply to your application: 

• Screen 

Select this box if the application writes directly to the screen (video 
buffer) or if the application has a .BAT extension and uses redirected 
I/O. All standard applications that display graphicS write directly to the 
screen. 

Selecting this option gives the application exclusive access to the full 
screen, rather than running it in a window. If you are uncertain, select 
this option. 

• Keyboard 

Select this box if the application accesses the keyboard buffer. This 
buffer saves keystrokes until they can be processed. 

Selecting this option prevents the application from running in a window 
(the application has exclusive access to the full screen) and prevents 
returning to MS-Windows with Alt/Tab. If you are uncertain, do not 
select this option. 

• COMl 

Select this box if your application accesses serial communications port 
1 (COMl). If you select this option, MS-Windows reserves COMl for 
the application. When the application is running, MS-Windows cannot 
run any other application using COM! until you stop running the first 
application. Generally, you select this option only if you are running a 
communications application. 

Selecting this option prevents two applications from trying to access the 
same communications port at the same time. Because only one applica
tion with the COM! option selected can be running at a time, only one 
application attempts to access COM!. 

Selecting this option also prevents the application from being swapped 
to a disk. This type of application must remain in memory at all times. 
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• COM2 

Select this box if your application accesses serial communications port 
2 (COM2). If you select this option, MS-Windows reserves COM2 for 
the application. When the application is running, MS-Windows cannot 
run any other application using COM2 until you stop running the first 
application. Generally, you select this option only if you are running a 
communications application. 

Selecting this option prevents two applications from trying to access the 
same communications port at the same time. Since only one application 
with the COM2 option selected can be running at a time, only one 
application attempts to access COM2. 

Selecting this option also prevents the application from being swapped 
to a disk. This type of application can remain in memory at all times. 

• Memory 

Select this box only if your application loads and remains resident 
(using a Terminate and Stay Resident system call). Many pop-up applica
tions do this. These applications generally load and remain in memory, 
and are activated while other applications are running. Generally, this 
type of application must be loaded before MS-Windows. In this case, 
you do not need a PIF for the application. If you are uncertain, do not 
select this option. 

C·lO 
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Program Switch 

If your application uses the entire screen, these options determine whether 
you can switch back to MS-Windows with Alt/Tab. If you are uncertain which 
option to select, select Text. 

• Prevent 

Select this option to conserve memory for the application, or if you find 
that the application does not switch to MS-Windows correctly. Selecting 
this option means you can stop running the application only by execut
ing its Exit command, or the equivalent command, to return to 
MS-Windows. You cannot use the Alt/Tab procedure to return to 
MS-Windows. 

• Text 

Select this option if your application works in text mode only, or if it 
runs in text and graphics modes, and you want to conserve memory. 
When you select this option, MS-Windows reserves 4K bytes to save the 
screen. 

If you select this option, you can switch back to MS-Windows only 
when your application is in text mode. If the application is in graphics 
mode, MS-Windows beeps when you press the Alt/Tab keys, to let you 
know it is not a valid action; you must execute the Exit command of the 
application to return to MS-Windows. 

• Graphics/Multiple Text 

Select this option if your application works in graphics mode. If you 
select this option, MS-Windows allocates extra memory (64K bytes) for 
you to switch back to MS-Windows when the application is in text or 
graphicS mode. 

Due to extensive memory requirements, program switching is not sup
ported for applications using IBM EGA high-resolution color modes. 
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Screen Exchange 

These options let you specify the kind of data exchange between applications 
that require exclusive access to the screen. 

You press Alt/Prt Sc to copy information into the Clipboard. This requires 
MS-Windows to allocate memory to save the screen image in the Clipboard. 
Text screens generally do not require much memory (2K bytes). However, 
graphics screens can require up to 64K bytes of memory. You should select 
options with this in mind. 

If you are uncertain which option to select, select Text . 

• None 

Select this option to prevent screen exchange and conserve memory. 

• Text 

Select this option to allocate memory to copy text screens. If your 
application runs in a window, you can select this option. 

• Graphics/Text 

Select this option to allocate memory to copy text and graphics screens. 

Close Window On Exit 

Select this option to close the standard application window when you exe
cute the application's Exit command, or its equivalent. 

When you exit from some standard applications, they display information in 
the window for you to look at or copy. Do not select this option, because the 
window closes automatically, and the information is not displayed on the 
screen long enough for you to read it. 
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Using Default Settings 

If you run an application, and MS-Windows cannot find a PIF, MS-Windows 
uses the following settings: 

• Program Title: The application file name is displayed in the title bar. 

• Initial Directory: You stay in your current directory . 

• Memory Required: 52K bytes 

• Memory Desired: All available memory 

• Directly Modifies: Screen 

• Program Switch: Prevent 

• Screen Exchange: Text 

Deciding What to Put in a PIF 

How an application is displayed on the screen depends on: 

• How the application uses workstation resources and hardware 

• How the application is configured 

• The amount of memory reserved for the application 

If MS-Windows cannot run a standard application in a window, it runs the 
application outside a window, and the application uses the entire screen. 

Use the following guidelines to help determine whether your standard appli
cation can run in a window: 

• Does the application write directly to the screen (video buffer)? 

Many standard applications write directly to the screen instead of using 
DOS or other system conventions to display information (such as ANSI 
calls). These applications cannot run in a window. You must select the 
Directly Modifies screen option if your application writes to the screen. 

• Does the application display graphics? 

Standard applications that display bit-mapped graphics (not character
based) write directly to the screen and cannot run in a window. 
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• Does the application provide an installation option for running under 
different screen conventions? 

Standard applications that support ANSI screen drivers can run in a win
dow. 

• How much memory does the application require? 

If the memory requirements of the standard application and 
MS-Windows together exceed the amount of available memory, the 
application cannot run in a window. MS-Windows "steps aside" and 
gives the application the maximum amount of memory available. 

• Does the application use the alarm? 

Applications that use the alarm function of the real-time clock must run 
outside MS-Windows. At the minimum, you should select the Directly 
Modifies keyboard option. 

For standard applications that run in a window, MS-Windows does not 
support the folloWing ANSI escape sequences: 

- Cursor Position Report 

Set Mode 

- Keyboard Reassignment 

Set Graphics Renditions subsets: 

Faint on 
Italic on 
Rapid blink on 
Subscript 
Superscript 

Select the Directly Modifies screen option in the PIF for any application 
that uses these. 

To experiment, run the application without setting the Directly Modifies 
screen option. If the application writes information outside its window, or 
you see unexpected results on the screen, edit the PIF and select the Directly 
Modifies screen option. 

C-14 
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Changing PIFs 

Generally, you do not have to change the information in the PIFs. However, 
to change any parameters for a particular application by editing a PIF, you 
can tailor the performance characteristics of its application. 

For example, to give Lotus 1-2-3 the maximum amount of available memory 
in your workstation, change the amount in the KB Required and KB Desired 
options to 640K bytes and select None for the Screen Exchange option and 
Prevent for the Program Switch option. Close all other applications except 
for the MS-DOS Executive, then run the application. 

Some applications provide an option to install and run the application with 
an ANSI device driver (ANSI.SYS). If the application offers this option, you 
can usually run it in a window. 

Since the application can now run in a window, you must alter the PIF. You 
should cancel the Directly Modifies Screen option. (Do this for all related 
.COM or .EXE files included in the application.) 

If you run an application, and it does not load properly or is not operating as 
expected, check your PIF settings. You may need to increase the memory 
requirements of the application. 

Giving Applications More Memory 

When you run a standard application, MS-Windows allocates memory based 
on the settings in the PIF of the application. MS-Windows allocates memory 
for screen exchange (copying the screen) and for program switching (switch
ing between the application and MS-Windows). 

You can reduce the memory requirements for an application by selecting 
options that require less memory: 

• The Screen Exchange Text option 

• The Screen Exchange None and the Program Switch Prevent options 
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